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The Presensational Learning Object Course Template Slide package is a PowerPoint® 2010 file that
helps you quickly and easily create courses in PowerPoint and publish them for Web delivery
using a variety of conversion tools.
This file (horton_tabbed_course_template2010.potx) provides a structure you can use to quickly and
easily build a course composed of learning objects. The file contains course-wide slides, such as
an introduction, a course map, a summary, post-test placeholder, resources, and certificate. The
file also contains five learning objects that use a tab metaphor for navigation. Simply use the
slides you need and delete the rest. Replace the text, graphic, and content placeholders, add
narration, and then publish for delivery over the Web. Note: The following instructions are
written for PowerPoint 2010. They assume you are familiar with this program and can perform
common procedures. If you need a refresher, take a look at the section Review the basic PowerPoint
skills you will need starting on page 22.

ACCEPTABLE USE
What can you do with these templates? In case you skipped over the legal agreement, or just
don’t remember the details, let’s review. You can use these templates to build slide presentations.
You can then show those presentations as often as you like. You do not have to credit our
templates, though we would not object. You can let other people show your presentations. Only
the person creating and editing the slides needs to buy a copy of our templates.
Only the person who bought these template slides can use them to create content. You cannot
give these templates away to others. Nor can you resell them either as is or part of your own
template package.

HOW THE SLIDE TEMPLATES WORK
Using slide templates, you can easily build a complete course.
1.

Open a new course structure file (horton_tabbed_course_template2010.potx).

2.

Fill in the graphic and text placeholders.

3.

Add content to the learning objects.

4.

Add tests and quizzes at the course and learning-object level.

5.

Connect the course menu (optional).

6.

Save, test, and refine the course.

Let’s look at these steps in more detail:

1. Open a new course structure file
Click on horton_tabbed_course_template2010.potx to start PowerPoint and open a new course
structure file. Before going further, save this file.
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2. Fill in the placeholders for course-wide slides
Review the available text and graphic placeholders. Fill them in (or edit then) with your own
content. If you do not need a type of slide, simply delete it. For instance, if you do not want to list
course objectives, delete that slide. If you do not want a course map, delete that slide too. This is
an overstuffed template file. We wouldn’t expect you to use every single slide.

3. Add content to the learning objects
There are five tabbed learning-object sets in this file. You may need fewer objects or you may
need more.
A learning object contains what is necessary to completely accomplish a learning objective. The
tabs on the left enforce the idea of “completeness.” That is, learners can see in one glance that
everything they need to know about a topic (as described by the Learning Object’s title) is right
here on these 5 tabs.
So, what do you put on each tab? Well, Tab 1 might be labeled “Introduction” and contain text,
graphics, and other media to acquaint learners with the problem or issue learners can solve or
accomplish upon completing this learning object. Tab 2 might be labeled “Assignment” and
outline an assignment for the learner to perform, and Tab 3 might be labeled “Resources” and
provide links to additional information to help the learner accomplish the assignment. Tab 4
might be labeled “Summary” and recapitulate the important points. Tab 5 could be labeled
“Practice” and contain an activity to help learners lock in these important points.
There are others strategies you might use for such a tabbed learning object. Take a look at the
examples on this page: http://horton.com/portfolioguidedresearch.aspx. The first example deals
with the issues surrounding controlled burns in National Parks. The second example teaches
learners how to navigate the conflicting policies regarding the concept of “minimum action”
wilderness areas.
Each of the tabbed slides has placeholders for text and graphics. They are just a suggestion.
Arrange the media as you see fit. If you further customize these template slides, save the file as a
template so that others on your team can use it too.
If you do not need all five tabs, delete the fifth slide of the learning object. And, be sure to delete
the tab for the fifth slide on the remaining four slides. If you need fewer learning objects, delete
the learning object you do not need. If you need more learning objects, then copy an entire group
and paste it after the last slide in the last learning object. You will need to redirect the links on the
tabs so that they go to the correct slide.

4. Add tests and quizzes
This file contains placeholders for a post-test and quizzes/tests after each learning object. If you
decide to include such assessments, here are some options to consider:


Build your tests and quizzes within the tool you will use to convert the PowerPoint slides
to a Web-ready format, such as Flash. There are several tools to consider, including
Adobe Presenter, Articulate Presenter, and iSpring Presenter.



Link to tests prepared in another tool, such as Macromedia Captivate or Hot Potatoes,
link to tests hosted by a testing service, such as HostedTest.Com, or link to tests created
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and hosted on your LMS (learning management system) or LCMS (learning content
management system).


Use informal self-check activities created directly in PowerPoint. There is a selection of
such slides in the Presensational Content Template slides package (sold separately).

For more detailed instructions see Include quizzes on page 19.

5. Connect the course menu
If including a course map, go to the Course Map template slide and follow the instructions in its
Notes field. Don’t forget to copy the Course Map button to each slide or to the slide master.

6. Save, test, and refine
Now that you have filled in your content, save and review the file in Slide Show view (F5). If you
are planning to use this course on the Web, convert the file using your chosen conversion
method. Carefully review the results to ensure that slide objects appear as expected and animate
smoothly.

THE LEARNING-OBJECT COURSE TEMPLATE—A DEEPER LOOK
Here is an overview of the slides included in the template file. Each different slide is discussed in
more detail under the section Individual slides and notes starting on page 7.
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Please, before you begin editing the course template slides, play them in Slide Show view (F5) to
see the animation effects that are built in.

Individual slides and notes
Here are the individual slides in the Learning-Object Course Template file
(horton_tabbed_course_template2010.potx). The notes to the right are the same as those in the Notes
field of the PowerPoint slide.
Here are some general instructions that didn’t fit on an
individual slide. Read them and then delete the slide.

Here are some more general instructions that didn’t fit on an
individual slide. Read them and then delete the slide.

The Course title slide identifies the course. It helps learners
confirm that they have launched the right course and
motivates them to dive right into learning.
Replace the Course title placeholder with the official name of
the course. It should be the same as the one the learner
selected to launch the course.
In naming your course, strive for a short name that clearly
communicates what the course does for the learner. Use
terms that the learner will recognize before taking the course.
Use the Course subtitle placeholder to elaborate on the title.
Make the subtitle up to three lines long.
Add any notices the learner must see before continuing, for
example, a safety warning or the requirement for a security
clearance.
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Before plunging into a course, potential learners need
information and orientation. Use the About the course
section to prepare learners to learn. Here you will find
template slides for much of what learners need to know
before commencing learning. We have been generous with
template slides here. Feel free to delete ones you do not need
in your situation. For a simple, short course, you may need
only a few of the template slides in this section.

Unless learners can navigate your course, they are not going
to learn. Include a slide or two to how to get around.
Because the exact user interface and navigation methods will
depend on your conversion process and tools, this template
can only offer general suggestions. Some tips:
 Create this slide after other aspects of your course are

stable. Otherwise the pictures will not be accurate.
 Replace graphics with snapshots from your course.
 Include generic instructions based on the user-interface

provided by your conversion process.
People are naturally curious about people, especially people
they are asked to trust and rely on for their own success. Use
the Your instructor slide to:
 Put a face and a personality with the name of instructor.
 Establish the authority and credibility of the instructor

and hence the course.
 Capitalize on the fame or reputation of the instructor

associated with the course.
Use a photograph that shows the instructor doing something
relevant, rather than the typical drivers-license photo.
Edit the description at the right of the photo to highlight the
qualifications of the instructor. An academic audience may
be more impressed with degrees and publications while an
industry audience may be more interested in successful
projects and awards.
Along with the instructor, you might want to introduce the
course author, narrator, or primary subject-matter expert.
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You may want to include a description of the course. The
Course description slide should serve as a reminder of the
complete course description learners should have read before
enrolling.
Other items you may want to include are:
 Fee
 Version
 Date
 Language
 Special bonuses or incentives
 Style of learning (WBT, blended, virtual classroom,

classroom)
 Alternatives, e.g., for accessibility.

Remember to edit the e-mail. To do that:
1.

Select the e-mail address.

2.

Right-click and choose Edit Hyperlink….

3.

Edit the e-mail address.

4.

Click OK.

Unprepared learners are cruising for disappointment. Before
you let learners get too far into the course, inform them of
what skills, knowledge, and attitudes they need in order to
take advantage of your course.
Use the Course prerequisites template slide to tell learners
what the course requires. As a courtesy, tell learners how
they can meet the prerequisites. If possible, include links to
other courses or Web sites where learners can start learning
the prerequisites.
To link to a Web address:
1.

Select the text to be the link trigger.

2.

Right-click and choose Hyperlink….

3.

In the Link to: section of the dialog box, click the
Existing File or Web Page button.

4.

In the Address field enter the URL of the resource.

5.

Click OK.
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The Course objectives slide tells learners in detail what they
will get out of taking the lesson. Use this slide to answer
questions learners have about what the lesson accomplishes
and to provide motivation for learners to complete the
lesson. Do not make a big deal about objectives. Just tell
people what they will individually gain by completing the
lesson.
Include a relevant graphic to show what learners will be able
to do after completing the lesson. You might, for example,
show an attractively styled report, a smiling team, or a
happy customer.
In the bullet list, tell learners what they will be able to do
(skill), come to understand (knowledge), or grow to feel
(attitude). Emphasize benefits that learners will value. Ask
yourself, “Can learners see how the objectives make them
healthier, wealthier, or wiser?”
If your learners are highly visual, consider replacing the
bullet list with a series of appropriate pictures illustrating the
outcomes you promise.
In designing the content of your course, use these objectives
as a checklist for learning objects to include. You may want
to include an object for each objective. Or, you may prefer a
less direct approach. In any case, you must create content to
accomplish each and every objective—or remove the
objective.
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The Course map helps learners see the “big picture”
organization of your course. If you add hyperlinks to the
map icons, it can also help learners quickly move around in
the course by clicking the appropriate icon on the map. To
return to the map, learners click the map button in the lowerleft corner of the slide.
After you have completed your course, you will need to add,
remove, or rearrange the icons, arrows, and the white boxes
beneath the icons depending upon the content of your
course. Then you will need to add or edit the hyperlinks on
each icon. To link an icon to a specific slide:
1.

Select the icon.

2.

Right-click and choose Hyperlink….

3.

In the Edit Hyperlink dialog box, click the Place in
This Document button.

4.

In the list that appears, expand the Slide Titles list.

5.

Choose the slide name from the list.

6.

Repeat for each icon.

7.

Copy and paste the Course Map button onto every
slide. You may want to add it to the slide and title
master, too.

For more, search for “About hyperlinks and action buttons”
in the PowerPoint Help.

Copyright © 2005-2010 William Horton Consulting, Inc. All rights reserved. Revised 6/2010

11

Presensational Learning Object Course Template Slides

A learning object contains what is necessary to completely
accomplish a learning objective. The tabs at the top enforce
the idea of “completeness.” That is, learners can see in one
glance that everything they need to know about a topic (as
described by the Learning Object’s title) is right here on these
5 tabs.
Take a look at some examples of tabbed learning objects on
this page: http://horton.com/portfolioguidedresearch.aspx.
The first example deals with the issues surrounding
controlled burns in National Parks. The second example
teaches learners how to navigate the conflicting policies
regarding the concept of “minimum action” wilderness
areas.
The Learning Object title slide marks the start of a subdivision of your course. Use it like you might use a level-two
heading in a document. The title should be sufficient to
communicate the learning object’s contents to most learners.
Keep the title short and use the subtitle (up to three lines) to
elaborate on the title. A good subtitle will imply what the
learner gains in this learning object. If the learning object
accomplishes a specific learning objective, you may want to
imply that objective in the subtitle.
To change the photograph to one that represents the theme
of the learning object:
1.

Select the photo.

2.

Right-click and choose Change Picture … .

3.

Browse for the new graphic (it doesn’t have to be a
photograph).

First of all, please remember that these tab labels are
arbitrary. We tried to create a generic learning object that
could be used as-is for a variety of training. Be sure to take a
look at some other examples of learning objects at :
http://horton.com/portfolioguidedresearch.aspx.
The Introduction tab uses text and other media to explain to
learners why this learning object is important and what
learners will be able to accomplish upon completion of the
object.
The title should be the same as that on the Title slide for the
object.
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The Presentation tab provides the knowledge, or Absorb,
component of the object. It can include text, graphics, video,
animation, and audio to present the main ideas of the
learning object..

The Practice tab provides a way for learners to ensure they
understand the content of the Presentation tab.
What can you place on this slide? Well, you can build an
activity from scratch using PowerPoint’s drawing tools and
Trigger Effects to provide interactivity.
If you are short on time, you can copy an activity from our
Presensational Content Template Slides (sold separately) and
paste it on this slide. You can also embed a Flash activity
(SWF) built in some other tool, such as Adobe Captivate,
using the Video tool on the Insert ribbon.
On the Summary tab, present the main points learners
should have gleaned from taking this learning object. The
summary should not just restate the objectives, but should
contain the key points necessary to accomplish those
objectives.

The Resources tab should provide ways to get additional or
deeper information about the subject of the learning object. It
could contain links to scholarly papers, books, articles,
forums, conferences, and job aids.
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The Learning object quizintroduction slide announces a
quiz, test, or some kind of assessment and provides
information the learner needs to begin it. This slide covers
the rules specific to the individual assessment.

Here you will need to insert a test. The way you do that
depends on how you will be converting your slides for
online delivery. Here are some options:
 Use a conversion tool such as Articulate Presenter,

Adobe Presenter, or iSpring Presenter to insert a test
right into your PowerPoint slides.
 Link to a test created in a separate tool, such as Adobe

Captivate or Hot Potatoes.
 Link to tests created and hosted on your LMS (learning

management system) or LCMS (learning content
management system).
 Link to a testing service such as HostedTest.com.
 Include some self-check activities from the

Presensational Content Template Slides (sold separately).
If you take this route, be sure to tell learners how to
score themselves.
Delete this placeholder slide.
Use this slide if you want to give learner’s more control of
their learning. Provide guidance on the action learner’s
should take based upon the score they received.
You may want to link re-take the learning object to the first
tab of the object, rather than the title slide of the object.
Be sure the Summary link points to the summary for this
lesson rather than the summary for the overall course,
another lesson, or a topic.
Link continue with the next learning object to the title slide
of the next learning object.
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The Course wrap-up may include a summary, a post-course
test, additional resources, information about the sponsor of
the course, credits, and a completion certificate. All of these
items are optional. Just delete the slides you do not need.

Use the Course summary slide to recap the most important
points of the course. Keep the points short and easy to
remember.
Summarize the content in short sentences or phrases. If a
summary item is more than a few lines long, left align its
text.
Compare your Course summary slide to your Course
objectives slide. The summary should not just restate the
objectives, but should contain the key points necessary to
accomplish those objectives.
If you have more than five or six important points, consider
breaking the course into multiple courses or reducing the
coverage of the course.
The Course post-test helps learners verify that they have met
the objectives of the course. In addition, the course post test
may be needed by your organization to document that
learners have mastered the course content.
The Course post-test introduction slide announces the
course test and provides information the learner needs to
begin the test. This slide covers the rules specific to the
individual test.
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Here you will need to insert a test. The way you do that
depends on how you will be converting your slides for
online delivery. Here are some options:
 Use a conversion tool such as Articulate Presenter,

Adobe Presenter, or iSpring Presenter to insert a quiz
right into your PowerPoint slides.
 Link to a test created in a separate tool, such as Adobe

Captivate or Hot Potatoes.
 Link to tests created and hosted on your LMS (learning

management system) or LCMS (learning content
management system).
 Link to a testing service such as HostedTest.com.
 Include some self-check activities from the

Presensational Content Template Slides (sold separately).
If you take this route, be sure to tell learners how to
score themselves.
For more information, see Include quizzes on page 19.
Delete this placeholder slide.
Use the Course post-test results template slide to help
learners decide whether they met their objectives. This slide
lists four ranges of scores. For each it suggests what learners
should do.
Notes:
 Link Re-take the course to the first lesson.
 Make sure Summary links to the course summary, not

the summary for an individual lesson or topic.
 If you deleted the Course prerequisites slide, remove

the hyperlink for “prerequisites” and provide an
alternative activity for learners to perform.
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Use the References – For more slide to provide learners with
suggestions on how to continue learning about the subject of
this course.
Add or remove elements as needed. If you add additional
elements, such as images or text, remember to give each
element a Fade or some other animation effect. And, be sure
to check the order each item appears using the Custom
Animation panel (available from the Animation ribbon).
Consider referring learners to job-aids, online discussion
forums, blogs, knowledge bases, help desks, Webinars, and
other sources of knowledge. To make links open referenced
Web sites:
1. Select the text you want as a link.
2. Right-click and choose Hyperlink… or type Ctrl-K.
3. Enter the Web address in the Address field.
4. Click OK.
Use the Course sponsor slide to tell learners who created or
offers the course. Don’t get egotistical, but do present the
credentials of the group providing the course.

Use the Credits slide if you wish to recognize the individuals
who contributed to your course.
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Congratulate learners and leave them with a warm feeling
and a sweet taste upon successfully completing the course.
Here is an idea: Prepare a real certificate in Microsoft
Publisher or other program and save it as an Adobe PDF
document. Then, provide a hyperlink on this slide that
learners can click to open the PDF document. From the
Adobe Acrobat window, they can print the certificate to their
local printer. Or ...
If learners log in to an LMS to access your course, then you
may be able to pair that log-in information with the learner’s
name and dynamically insert the name into a placeholder in
the certificate. You will need to talk with your IT department
to see what is possible.
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STRATEGIES FOR USING THESE TEMPLATE SLIDES
You have purchased our template slides. Now you need to make them your own. We suggest
you do several things: customize the appearance of the template slides to reflect your
organization’s style guidelines, consolidate the template slide files and re-sequence them as
necessary, and then add the quizzes.

Template-wide customization
Colors. To change the colors of the background, tabs, and text, we recommend that you edit the
Theme Colors (LearningTemplatesPalette) and reassign the colors for all the objects on each master
slide. This is a little tedious, but if you use a specific template for all your other learning
materials, you will probably only make these edits once so that it will harmonize with your
existing slide template.
The main reason for making color changes using the theme colors is to ensure that when
someone else uses this template to create a learning object, the colors you have carefully chosen
cannot easily be changed by accident. Yes, you can make color changes ad hoc without editing the
Theme Colors.
Fonts. This template uses the Office Theme Fonts. To change the fonts used, do so by changing
the Theme Fonts, rather than changing fonts ad hoc on each slide. The title slide and the tabs use
Courier New. This is font is not part of the Theme fonts
Copyright. To change the copyright notice, select Header & Footer on the Insert tab and edit the
text in the footer text box.

Add or remove templates
If your courses follow a common pattern, you can streamline production by adding or removing
individual template slides. For instance, if your courses typically have six or seven learning
objects


Open the lesson template.



At the appropriate place, insert the topic template six times.



Save the modified lesson template.



Open the course template.



At the appropriate place, insert the modified lesson template five times.



Save the modified course template.

Include quizzes
PowerPoint does NOT provide a mechanism to build scored or tracked quizzes or tests. You
must link to assessments created and hosted elsewhere or use capabilities provided by some
PowerPoint conversion tools.
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With Adobe Presenter®
The Adobe Presenter® PowerPoint plug-in allows you to add true/false, multiple-choice, and
multiple-answer quizzes. These quizzes may communicate with a learning management system
using either AICC or SCORM protocols.
These quizzes are represented in your PowerPoint file by a quiz placeholder. When the file is
published for Web delivery, each quiz is built and the entire file is converted to Shockwave
Flash®.

With Articulate Presenter®
If you own Articulate Presenter®, the Articulate PowerPoint plug-in allows you to add true/false,
multiple-choice, sequence, or word game (like hangman). These quizzes may communicate with
a learning management system using either AICC or SCORM protocols.
In addition, Articulate has a standalone program called Quiz Maker in which you can create a
wider variety of assessments, which also can communicate with a SCORM-compliant
LMS/LCMS. These assessments can then be integrated into your PowerPoint file.
Articulate’s quizzes are represented in your PowerPoint file by a quiz placeholder. When the file
is published for Web delivery, each quiz is built and the entire file is converted to Shockwave
Flash®.

With iSpring Presenter®
The iSpring Presenter® PowerPoint plug-in allows you to insert ten types of quiz questions –
including cloze questions. These quizzes may communicate with a learning management system
using either AICC or SCORM protocols.
These quizzes are represented in your PowerPoint file by a quiz placeholder. When the file is
published for Web delivery, each quiz is built and the entire file is converted to Shockwave
Flash®.

With a separate test-creation tool or service
You can also create assessments using a variety of authoring tools and services, and then link to
the assessments from within PowerPoint.
Tools and services for creating external assessments
Here are some popular tools used to create assessments:


Adobe Captivate® is a desktop tool most often used to create software simulations.
However, it also makes it easy to create a variety of test questions as well as scenariobased activities. Go to http://www.adobe.com/captivate.



Questionmark Perception® is a server-based tool that allows you to create, deploy, and
administer a variety of question types. Questionmark Perception is SCORM 1.2
compliant and may be integrated with certain LMSs and LCMSs. Go to
www.questionmark.com for more information.



Hot Potatoes from Half-Baked Software is a desk-top tool that produces a variety of
question types in the Java. Results can be reported to a server using CGI script or sent to
an individual via e-mail. Go to http://hotpot.uvic.ca for more information.
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Random Test Generator-PRO from Hirtle Software is a desktop tool that allows you to
create a wide variety of question types using HTML and JavaScript. Go to
http://www.hirtlesoftware.com for more information.



QuizPoint from LearningWare, Inc. is an online service that allows you to create a
variety of question types in the Flash® format and administer their delivery. Results can
be sent to you via e-mail, or you may select to have users' results written to the database
of your choice. Go to http://www.learningware.com for more information.



Hosted Test® from HostedWare, Inc. is an online service that allows you to create a
variety of question types and administer their delivery. Go to http://www.hostedtest.com
for more information.

For more testing tools, go to horton.com/tools.
Linking to external assessments
You link to assessments in the same manner you would link to any other external resource.
1.

Insert a blank slide with the title of your activity.

2.

Add a link trigger, such as a screen shot of the assessment or just some text.

3.

Right-click on the screen shot or text and select Hyperlink….

4.

Type in the URL to the assessment. The URL can be relative or complete. If you use a
relative URL (one that is based on the location of the presentation), the assessment must
always be located in the same location relative to the converted PowerPoint file. If you
use a full URL (http://www.something.com/whatever), the assessment can be anywhere
on the Internet.

With an LMS/LCMS testing module
Many LMSs and LCMSs provide tools for creating assessments. Once created, there are a variety
of ways to make them available to learners. How you choose to do it will depend upon the
management system you are using and the procedures you have in place for authoring and
delivering courses.

With informal self-check activities
If you do not need scores or other types of data, then consider building self-check activities
within PowerPoint.
The Presensational Content Template Slides (sold separately) contain templates for building a
number of self-check activities. They contain matching, multiple-choice, true/false, short-answer,
and click-in-picture activities.
You can purchase the Presensational Content Template Slides at http://www.horton.com.

CONVERSION NOTES
If you are creating courses for Web delivery, you need to think about how to convert them so that
they are Web-friendly. In this section are some conversion tools you may want to consider. To
learn more about them, go to their respective Web sites.
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Conversion methods and tools
This is not an exhaustive list of conversion methods. For more, go to www.horton.com/tools.


Save As à HTML (Web page) command from within PowerPoint, office.microsoft.com



PowerPoint Producer 2007 is available from connect.microsoft.com



Articulate Presenter, www.articulate.com



Adobe Presenter, www.adobe.com



iSpring Presenter, www.iSpringsolutions.com



Impatica for PowerPoint, www.impatica.com



PowerConverter, www.presentationpro.com

Issues to consider
When choosing a conversion method to make PowerPoint Web-ready, here are some issues to
consider:


What PowerPoint features are preserved?



Does the tool produce HTML, Java, Flash, Windows Media, Real Media, or a
combination of these formats?



What player is required?



Can narration be tightly synchronized with animation?



What is the file format of the converted audio? For instance, is it converted to a webready format like MP3?



Is the conversion method a product or service?



Does the conversion tool or method add additional features—like assessments, table of
contents, functional interface, or administrative tools?

REVIEW THE BASIC POWERPOINT SKILLS YOU WILL NEED
This section contains instructions for the tasks you will need to perform to get the most from
these templates. This is not a tutorial on PowerPoint but just a quick reminder of some crucial
procedures. These instructions are for PowerPoint 2007.

Delete unneeded objects
Select the object you want to delete, and then hit the Delete key. Alternatively, from the Home
tab, select Cut.

Duplicate slide objects
You often must duplicate existing slide objects. To do so simply:
1.

Select the object you want to duplicate.

2.

Hold down the Ctrl key and press the D key. The copy will appear a little to the right
and a little below the original object. And, it will be selected.
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Group objects
You will often need to group a number of objects together so that they can be manipulated as one
object. Here’s how:
1.

Select the first object you wish to group.

2.

Hold down the Shift key and select the other objects you want to add to the group.

3.

On the Home tab, click Arrange in the Drawing section of the Home ribbon

4.

Select Group.

Even easier:
1.

Select the items to group.

2.

Right-click and choose Group in the context menu.

3.

Then choose Group in the submenu.

For you power users out there, there is a Selection and Visibility pane that displays a list of all
the objects on your slide. You can use it to check the items you want to select. This is useful if
some of the items you want to select are behind other objects. It is available from the Select menu
item on the Home ribbon.

Ungroup objects
This one is really easy. Just click on the group. Right-click, choose Group, then choose Ungroup
in the submenu.
Tip: If you wish to group the items again, just select one of the items in the old group, right-click
and choose Group, then Regroup.

Edit text in placeholders
Edit placeholder text or sample text as you would in Microsoft Word®.
Place your cursor right before the first letter of the first word of the text you want to edit.
Hold down the Shift key.
Place the cursor after the last letter of the last word of the text you want to edit. (All the text
should be highlighted.)
Edit the text.
Shortcut: Another way to select text is to double-click to select a whole word, Ctrl-click to select
an entire sentence, or triple-click to select an entire paragraph.

Copyright © 2005-2010 William Horton Consulting, Inc. All rights reserved. Revised 6/2010

23

Presensational Learning Object Course Template Slides

Change text color
You can change the color of a letter, a word or group
of words, or a text box. Simply select what you want to
recolor, and then click the downward-pointing arrow
next to the font color button in the floating formatting
pallet.
Either select one of the colors shown or click More
Colors… to choose another color.

Change line color
Just as you can change font
color, you can also change the
line color of text and drawing
objects. Simply select what you
want to recolor and then rightclick and choose Format Shape.
In the Format Shape dialog box,
make the changes you wish.
Notice how many characteristics
you can control from this one
dialog box!
You can also change line color
by clicking the Shape Outline
button tab in the Drawing
section of the Home ribbon.

Change fill color, fill effect, and transparency
You can easily change the fill color for text and drawing objects. Just select what you want to
recolor, right-click, and choose Format Shape. In the Format Shape dialog box, you can change
the fill color, fill effects, and fill transparency.
Experiment with these options to see how they work.
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Arrange objects
As you add objects on a slide, you will often need to change their front-to-back order. That is, you
must control which object appears in front of or behind other objects. This is an easy process.
1. Select the object you want to change. In this example, we want to move the small block
out from behind the large block—that is, bring the small block to the front.
2. Select the small block and right-click.
3. Choose Bring to Front from the context menu.
4. Then, choose Bring to Front from the submenu.
5. Adjust the position of the small block and you’re done.

Adjust animation order
As you modify the template slides, you will often have to change in what order objects on your
slide animate. Animation refers to how objects first
appear, disappear, move, or change characteristic on a
slide.
Take a look at the example to the right. The bottom block
wipes on before the arrow. We need to change the
animation order of the arrow:
1.

Click the Animations tab.

2.

Select Custom Animation in the Animations
section of the ribbon to display the Custom
Animation panel docked to the right side of the
PowerPoint window.

3.

On the slide, select the object whose animation
order you want to change—in this case the arrow.

4.

Select the highlighted object in the
Custom Animation panel. Notice that
it is now bordered in blue.

5.

Using the Re-Order arrows near the
bottom of the Custom Animation
panel, move the selected object up or
down into the desired order—in this
case we will move the arrow (labeled
Right arrow 3) up just before the
bottom block (labeled Rectangle 4).

Caution: Some objects may have multiple
animations. When you select them on the slide, more than one item will highlight in the Custom
Animation panel. Make sure you select just the item you want to reorder before making any
changes.
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Adjust animation direction
As you customize these template slides, you will need to
change the direction of an animation effect. For instance,
if you use arrows to show how a process flows left to
right, you want to make sure that the arrows all wipe
left to right. In PowerPoint parlance, left-to-right is
called “From Left.”
1.

On the slide, select the item whose animation
direction you want to change.

2.

Display the Custom Animation panel.

3.

Next to Direction:, click the downward-pointing arrow to see the direction choices you
have.

4.

Select the appropriate direction.

Note: Not all animation effects have directions.
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